
WARGI: Water Resources System

Optimisation aided by Graphical Interface

Giovanni M. Sechi and Paola Zuddas

Dipartimento di Ingegneria del Territorio, DIT, Hydraulic Section,
University ofCagliari, 09123, Italy

Abstract

An optimization tool for water resources system planning and management,
named WARGI, is proposed in the paper. The optimization tool utilizes a
graphical interface to allow the user a friendly data-input phase and to visualize
output results. It is easy for the user to modify system configuration and related
data to perform sensitivity analysis and to process data uncertainty using scenario
optimization. WARGI allows to start from the physical system to reach the
optimal solution having the possibility to control all the intermediate phases,
easily to update system configuration and to consider different optimizers. The
graphical interface WARGI prevent obsolescence of optimizer codes exploiting
the standard input format MPS. An application of WARGI to a real system is also
described.

1 Introduction

Modeling tools for water resources planning and management (WRPM)
optimization have been developed since the early '60 [9] using standard
optimization tools. Much has been written and proposed in these years to reach
the economic efficiency and the optimal water allocation in complex system using
different algorithmic approaches [8],[17]. At this time most of the easier water
system configuration has been generally realized and; nevertheless, the increasing
needs of an adequate, efficient and sustainable use of water is a crucial world-
wide problem. As WRPM needs to consider different physical components,
planning and operation rules, related models grow up to very large dimensions.
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110 Hydraulic Engineering Software VIII

Moreover, a significantly extended time horizon must be considered in order to
adequately represent hydrological input and demands. Recently very efficient
computer codes for general purpose mathematical programming are available
supporting up to thousand of variables and constraints. A crucial factor treating
large dimension problems with these efficient general-purpose algorithms is
becoming the availability of efficient computer graphical interfaces designed to
facilitate the use of models and database in a decision support system (DSS)
context to help end-users to evaluate the best choice in a friendly-to-use way.
The main features of the proposed WRPM optimization tool, named WARGI, are:

Friendly to use in input phase and in processing output results.
Prevent obsolescence of the optimizer exploiting the standard input format in
optimization codes.
Easy to modify system configuration and related data to perform sensitivity
analysis and to process data uncertainty.

"Prevent obsolescence" and "easy updating" are strictly connected aspects. To
prevent the risk of an early useless, the tool has been assembled as transparent
boxes collection, composed by independent modules, in such a way each module
can be easily managed.
The main boxes inside the graphical interface are:

System elements characterization.
Connections topology and transfer constraints.
Links to hydrological data and demand requirements files.
Time period definition and scenario settlement.
Planning and management rules definition.
Benefits and costs attribution.
Call to optimizers.
Output processing.

WARGI allows to start from physical system to reach the optimal solution having
the possibility to control all the intermediate phases, easily to update system
configuration and to consider different system optimizer using standard data-input

format.

2 Water resource systems optimization

A mathematical model for WRPM involves a large number of variables and
constraints in order to represent adequately several aspects of the problem.
Considerable progress have been made in optimization by methodological point
of view and improvement in computational performances are made day by day
producing very efficient computer codes. These last few years great effort has
been made in reducing gap between mathematical methodology and real world
applications in WRPM coming from different scientific communities in spite of
seldom interactions in the past [13] [6]. WRPM tools have been recently
produced [1] [3], containing representation, simulation and optimization software
with the aim to be friendly for users but strictly linked to their resolutive tools.
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Hydraulic Engineering Software VIII 111

On the other hand, in the field of optimization, improvements in mathematical
programming methodologies are not generally referred to a specific application
but exploit special algebraic structures of models. In this contest great progress
have been made in computational efficiency of resolutive technique of linear
programming problems. New polynomial time algorithms alternative to simplex
methods have been developed as interior point methods, network oriented codes
with complicating constraints, new graph structures, etc.[14] [2] [7]. By
implementation point of view, advanced codes in mathematical programming
allow to adopt the more suitable performance of the package depending on the
structure of the matrix constraints: sparse matrix, graph structure like node-arc
incidence matrix, bounds, block diagonal matrix, tridiagonal matrix, etc., each of
them coming from particular physical, economical, technical constraints.
Inside the scientific community the necessity to adopt a standard format for data
arose in order to allow comparisons among different approaches to verify
efficiency of algorithms and codes as in a wide variety of test problems [4] as in a
wide variety of real world applications.
Recently the MPS format has been adopted as standard data format and used by
almost all optimization software developers [5] [14] [16].
In such way, as showed in previous papers, the possibility to compare different
"general purpose" linear programming codes in WRPM gave rise to specialized
tools exploiting end users experience. This approach seems adequate to problem
complexity and to the generally huge size of the model leading to good strategies
of choice.
In other words a first level interface oriented to MPS standard format should
allow to take advantage of the progress in optimization methodology and codes
efficiency in implementing water resources optimization.
A second level interface oriented to end-user allows to perform an advanced
optimization even if the user is not familiar with mathematical programming
techniques.
WARGI tool adds features of first and second level interface: user can exploits
his scientific knowledge and experience to perform a wide experimentation in
different optimizer tools performing scenarios analysis and sensitivity
backtracking or can follows standard suggestions and, in case, tuning some
system parameters.

3 WARGI Scenario Optimization

As extensively described in some previous papers [10] water resources decision
problems with a multiperiod or multistage feature are typically characterized by a
level of uncertainty on the value to be assigned to crucial parameters. On the
other hand any possible value assigned to them can invalidate the results of the
study. When the statistical information about data estimation are not enough to
support a stochastic model, scenario analysis approach can be adopted modeling
WRPM under uncertainty in order to rich a robust decision policy minimizing the
risk of wrong decision.
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112 Hydraulic Engineering Software VIII

One of the main goal in WRPM study is to reach a configuration that should
guarantee an adequate level of reliability of water supply and provide
management criteria to be adopted by the Water Authorities.
In WRPM uncertainty is mainly referred to cost-benefits or demands-supplies
parameters. This is a typical problem in which the level of uncertainty cannot be
represented by a probabilistic rule. Alternatively, uncertainty on input data can be
represented by a set of version of synthetic series (scenarios) derived from
historical data.
We can represent this procedure with a graph structure, the scenarios tree, in
which each node represents a point in time where a decision can be made. The
scenarios tree is the structure of the set of scenarios along the planning horizon,
generated from the user defined strategies. Each root-to-leaf path represents a
scenario that is one possible realization of the unknown parameter.
In real systems the graph "explodes" in dimension with the increasing of the
possible configurations number.
This approach leads to a huge multi-period model composed by a small number
of versions of subproblems, each referred to each scenario, that correspond to the
available information level until the moment to take the planning decision. In this
context it becomes crucial to have the possibility to adopt the best state-of-the-art
mathematical programming code, as WARGI can do.
Studying the scenarios optimal solution, one may be able to discover similarities
and trends and to model a decision support system quantifying the risk of
planning operations. Moreover each scenario can be weighted in order to
represents the "importance" assigned to the running configuration.
The minimizing of the difference between the decision policy waited cost and the
solution optimum under each scenario gives the "robustness" required to the
method, which leads to a "barycentric" solution, which respects different possible
weighted scenarios.
Scenarios can be generated by time-cluster aggregation with different temporal
lags using several techniques AR models, Neural Nets approach or Monte Carlo
generation.

4 Physical system formalization

Following the physical-system formalization adopted in previous works [11] [12]
and recently used in the WARSYP Project [15], the water resources system can be
viewed as a physical network where nodes and arcs are as follows:

Reservoir nodes: these represent surface water resources with storage
capacity. In these nodes losses by evaporation can be considered.
Demand nodes: as for irrigation, civil, industrial among others. They can be
consumptive or non-to tally consumptive water demand nodes.
Hydroelectric nodes: they are non consumptive nodes associated to
hydroelectric units .
Confluence nodes: such as river confluence, withdraw connections for
demands satisfaction, etc.
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Hydraulic Engineering Software VIII 113

Aquifer nodes: these nodes represent ground water resources with storage
capacity.
Natural stream arcs: these represent the natural runoff along rivers or river
beds.
Conveyance work arcs: these are artificial channels as ditches, pipes, etc.
Water pumping facility arcs: these are arcs with a pumping plant.
Emergency transfers arcs: these arcs allow transfers of water to face
shortage.
Recharge facility arcs: these allow direct injection of surface water from a
connection node into an aquifer.

Some of the operational management issues to consider in the problem can be
easily modeled using graph structures as the following:

Priorities in the stored water level of reservoirs:
Priorities in demand satisfaction of demand nodes.
Penalty on shortage and emergency transfers.
Water quality aspects related to storage conditions.

The planning issues refer to the design of the physical system as dimensions
associated to future works: reservoirs capacities, pipes dimensions, irrigation
areas, etc. Other planning aspects are related to unit consumptive use demands,
irrigation technologies and agricultural assessments.

5 WARGI graphical interface

The interface has been developed and tested within an HP-Unix and PC-Linux
environment. The various software components have been coded in C++ and
TCL-TK graphic language.
The WARGY graphical interface provides the possibility to insert the basic
system configuration components and connections between them. As shown in
Figure 1, the main window presents an empty canvas and the program window is
composed of several parts as described below:
Title - The name of the current graph (NoName if the graph is new and has not
been saved).
Menu Bar - The menu bar for selecting various options and tasks.
Scroll Bars - Permit scrolling the canvas in order to use a canvas larger than the
size visible on the screen.
Status Bar - multi-function bar providing information on graphical objects and
also acts as a guide during graph construction.
The tool palette is a small window containing a set of graphical objects needed for
creating graphs. In order to open the tool palette, the user has to call the View
menu and select Tool Palette. The tool palette window will open and can be
dragged into a suitable position on the screen.
The tool palette is composed of a number of buttons, each representing a
graphical object or an action that can be performed on the palette or a graphical
object placed on the canvas. The main objects that can be inserted in the window
are:
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114 Hydraulic Engineering Software VIII

Reservoirs;
Civil demands,
Industrial demands;
Irrigation demands;
Hydroelectric Power stations;
Confluence nodes;
Conveyance structures
Natural streams.
Aquifers

Two buttons on the tool palette have an effect on the tool palette itself. The ?
button toggles the text description on the right of the button icons. The text
description is useful for new users who are not familiar with the symbols used for
creating graphs. The OK button is used to close the tool palette once graph
creation is complete.
Placing nodes on the canvas is a two step process. Firstly, the user must have the
tool palette open. This will give the user access to the various node types that can
be used.
The first step to placing a nô ^ wish to

File View Configure Run

Reservoir

Civil Demand

Industrial Demand

Irrigation Demand

Hydroelectric Power Station

Confluence

FXU

i * i Normalize cursor

Kg Cancel edge or node

I ?

OK

Figure 1: Main window and palette of WARGI.
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Hydraulic Engineering Software VIII 115

place from the tool palette. This is done by clicking on the icon representing the
node in the tool palette using the left mouse button. The selected node type will be
highlighted. The second step is actually placing the node on the canvas. Simply
moving the mouse over the canvas to the point in which the user wishes to place
the node and press the left mouse button.
Once the node has been placed on the canvas the user may proceed to inserting
the data associated with the node or continuing the graph-creating process.
Placing arcs is slightly similar to placing nodes and requires 3 steps using the
mouse.
Using the tool palette it is possible to delete graphical objects from the canvas,
selecting the Cancel Edge or Node from the tool palette.
Once the graph has been completed or a new node or arc has been placed on the
canvas it is necessary to insert the data related to the object. This is done through
a template window which is accessible by clicking on the graphical object using
the right mouse button. The template window is different for each type of object
placed on the canvas.
In Figure 2 the input windows for reservoir objects is shown.
Some sections of the template windows can be accessible in the case of project
optimization, others in operational optimization

Reservoir; 00 in Project ^ Operational

Name

Max Capacity [Mmc]

Ratio (max usable volume )/capacity \ dick to edit values ; | Cyclic •- |

Min Capacity [MmcJ
„..„ .„ „ ...._.„.„..,.„.„...........„._......
Ratio (min stored volume)/capacity I dick to edit values : Cyclic ••-- \

Construction Cost I

Gradient of S~V Iine[

Unitary Evaporation Values [m] I Qick to edit values 11 Cyclic

Hydrological Input [MmcJ f ... [ Vector -* |

Spilling Cost | Scalar - |

Figure 2: Input windows for reservoir objects.
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116 Hydraulic Engineering Software VIII

Once the graph has been completed and all the necessary data has been inserted, it
is possible to generate the necessary MPS file to feed to the solver.
MPS file generation is achieved by selecting Generate MPS from the File menu.
Graphs may be saved and previously saved graphs may be loaded by using the
File menu. When a graph becomes too large to fit on the currently visible canvas,
it may be helpful to scroll and zoom the canvas to have a better understanding and
vision of the graph the user is creating. It can be done by selecting Scrolling and
Zooming from the View menu.
In order to be able to launch the solver from the Graphical User Interface the user
must first set the command line required to launch the solver. This is done from
the Configure menu by selecting Solver. Once the required command has been
inserted in the space provided clicking OK will set the command line for
launching the solver.
At the end the user can visualize results using View results and Plot results
options from the View menu.

6 WARGI application to Flumendosa-Campidano-Cixerri water

resource system

The use of WARGI software to a real water system has been tested using, as
reference scheme, the Flumendosa-Campidano-Cixerri water sytem (Sardinia-
Italy) as provided by the WARSYP Project [15]. Since 1987 the Sardinia-Water-
Plan points out the necessity of defining an optimal water works assessment and
the urgency to find optimal management rules for the water system. These
requirements became more and more urgent in time, as the system managers had
to face the serious resource deficits resulting by the drought events of the past
decade.
The Flumendosa - Campidano main works were built in the mid *50's and supplies
most of Southern Sardinia. The main water supply source of the system is
represented by the three reservoirs of Flumineddu, Flumendosa and Mulargia with
a total storage capacity of 666.4 millions of cubic meters (Mm̂ ). The reservoirs
are connected by gravity galleries. In the system there are not remarkable aquifers
to be considered.
As illustrate in Figure 3, the principal works are the following:
Water supply sources

Capanna Silicheri dam on the Flumineddu river (3.6 Mnf);
Nuraghe Arrubiu dam on the Flumendosa river (316 Mrn̂ );
Monte su Rei dam on the Mulargia river (347 Mm̂ );
Sa Forada de S'Acqua dam (1.6 Mm̂ );
Casa Fiume dam on the Fluminimannu river (1.1 Mm̂ );
Simbirizzi dam (33.8 Mm̂ );
Genna is Abis dam on the Cixerri river (30 Mrr̂ );
Is Barrocus dam on the Fluminimannu river (14 Mnf);
Monastir weir on the Rio Mannu river;
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Hydraulic Engineering Software VIII 117

Rio Fanaris weir;
Rio di Monti Nieddu weir;
Rio di S. Lucia weir;
Assemini weir.

Modello del sistema idraulico della zona idrograflca Flumendosa-Campidano-Cixerri
1 serbaloio Flumineddu a Capanna Silicheri2 sertoaloio Flumandosa a Nuroghg Arrubiu3 serbalolo Mulargki
5 serbaloio Sa Forada de S'Acquo a Santu Mioli6 serbalolo Flumlnlmannu a Casa Flume7 Iraversa sul Flumendoso a Villanovctulo8 soltevamento Impianto sulla 1rav«rsc dl Villanovatulo9 serbaloio Fluminimannu ad Is Barroccus10 conflusnzc11 traverse sul rlo Fanaris

12 porabile Sulcis13 tra sul rio Santa Lucia14 confluenza15 serbaloio Cixerri a Genna Is Abis16 confluenza
17 confluenzc18 sollevomenlo impianto di sollflvamenl19 conflu»nza20 irriguo Ufa21 solkvamenlo Impianto Machlareddu22 conflusnza23 irriguo San Spero1e-Monastir_Elm<is
25 Iravorsa sul rio Monti Nieddu26 potabils Su<i-0ccid«ntcle

30 industriaie Sarroch31 irriguo Elm s ABC32 condusnzc33 irriguo Elmos ABC34 traverse sul Mcnni a35 irriguo SE136 potabile Santu Mioli37 c imnza38 potabile S. Lorenzo39 solkvamenlo Simbirizzi40 porabile S«tlimo S.P.41 irriguo Satorgius Quarlu
42 serbalolo Simbirfzzl43 porabile Gerrei44 irriguo canals adduttore45 irriguo So Forada46 potabile Sarcidano47 irriguo EO_NO_S0148 porabile Donori

Figure 3: The Flumendosa-Campidano-Cixerri water system.

Water diversion and communication galleries
Flumineddu - Flumendosa communication gallery (6,890 m, 13 nf/s);
Flumendosa - Mulargia communication gallery (5,917 m, 95 mVs);
Uvini - Sarais diversion gallery (9,920 m, 52 nf/s).

Main water supply and distribution network
Main supply canal (20 Km, 54 nf/s);
East - West distribution canal (10.7 Km, max. 30 mVs);

North-West distribution canal (21.6 Km, max. 7 mVs);
South - West distribution canal (25.8 Km, max. 11 nf/s);
South - East distribution canal (54.3 Km, max. 11 mVs);

Hydroelectric power stations
Uvini power station (13 MW)
Santu Miali station (25 MW)

Irrigation distribution network
The irrigated district is about 70.000 gross hectares

Pumping stations
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118 Hydraulic Engineering Software VIII

Flumendosa (4 x 3,000 1/s pumps, head 23 m);
Simbirizzi Main (6 x 1,300 1/s pumps, head 40 m);
Pumping station no. 1 for the supplementary aqueduct of the City of Cagliari
(4 x 475 1/s pumps, head 40 m);
Pumping station no.2 for the supplementary aqueduct of the City of Cagliari
(4 x 550 1/s pumps, head 40 m);
Opera Nazionale Combattenti (6 x 340 1/s pumps, head 45 m);
Cixerri (4 x 1,000 1/s pumps, head 47 m);
Sulcis (5 x 121 1/s pumps, head 270 m);
Macchiareddu (4 x 670 1/s pumps, head 70 m);
Monti Nieddu (4 x 120 1/s pumps, head 25 m);
Assemini (6 x 245 1/s pumps, head 35 m);

Sestu (5 x 240 1/s pumps, head 15m).

File View Configure Run

lrrisu«

t ravers* f«l ri* S*ata Uicte

Figure 4: The input window for Flumendosa-Campidano-Cixerri water system.

Water plants for drinking purposes
Simbirizzi potabilisation plant (c. 5,040 mVh)
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Hydraulic Engineering Software VIII 119

Donori potabilisation plant (c. 2,520 mVh)
The following is the yearly average distributed volume (mean of the 1992-1994)

Drinking: 80 Mrn^
Industrial: 15'.
Agricultural: 1

Total: 225 Mnf

The input window of the examined system is give in Figure 4.
Using WARGI, extensive investigations on water system optimization can be
made considering different hydrological and demands scenarios and setting
branches and stages of the scenario tree. Optimization results can be shown as in
the graph reported in Figure 5 for the optimal flow achieved for Flumendosa and
Mulargia reservoirs. WARGI application to Flumendosa-Campidano-Cixerri
water system, results and comments are extensively reported in [10].

Medio Flumendosa-andamento temporale del volume invasato nel periodo fra il 1982-83 e il 1996-97

011-82 011-83 011-84 011-85 011-86 011-87 011-89 011-90 olt-91 011-92 olt-93 Ott-94 ott-95 011-96
mese

Figure 5: Optimization results.

7 Conclusions

The aim of authors in planning WARGI was to create a tool to help water
managers in a DSS context, friendly to use but able to take into account the
improvements made in the field of computer science and operation research. The
state of the art in Mathematical Programming codes evolves continuously
producing algorithms that improve computational efficiency thanks to new
methodologies and computer science development. The standard input format
allows to insert the best state-of-the-art codes in WARGI.
Several improvements are in progress in WARGI like validation by simulation
testing phase, sensitivity analysis, among others.
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